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What’s New in DataCAD 12? 
DataCAD 12 has many new and improved features which are designed to help 
you increase productivity. Some changes affect compatibility with previous 
versions of DataCAD and with other programs. 

Compatibility Enhancements 
Forward/Backward Compatibility with Other DataCAD 
Versions 
DataCAD 12 is compatible with drawing files, symbols, templates, line types, 
hatch patterns, fonts, and DCAL® macros from DataCAD versions 4 through 11. 
That means migrating your designs to DataCAD 12 is effortless. 

DataCAD 11 cannot open drawings from DataCAD 12, however, you can save 
your DataCAD 12 (AEC) files to DataCAD 11 (AEC) file format using the File \ 
Save As DataCAD 11 AEC menu option within DataCAD 12. This is especially 
helpful if your office has copies of both DataCAD 11 and 12 running on various 
computers and you need to exchange files with another user. 

DataCAD versions 4 through 10 cannot open drawings from DataCAD 11 or 12. 
If some of your associates are running these older versions, you will not be able 
to share your DataCAD 12 files directly with them.  You’ll have to use 
DXF/DWG as a common file format. 

Compatibility with AutoCAD® Drawing Files (DXF/DWG) 
DataCAD 12’s drawing translator can import DXF and DWG files compatible 
with AutoCAD R12‐R14, R2000‐R2002 (R15), R2004‐2006 (R16), and R2007‐R2009 
(R17). You can choose an automatic translation or an interactive one, where you can 
decide how each line type and font should be translated and displayed in 
DataCAD. 

Block Attributes appear as Symbol Attributes when you open a DWG file. 

 To import a DWG or DXF file and open it in DataCAD: 

1. Select Open from the File pull‐down menu. The Enter name of drawing file to 
open dialog box appears. 

2. Select DWG or DXF from the Files of type drop‐down box. Choose DWG 
to display all DWG files or select DXF to display all DXF files. 
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3. Select a file to import from the list or type the name of the file to import in 

the File name input box. By default, DataCAD looks for DXF and DWG 
files in your DataCAD\Transfer folder. If your DXF or DWG files are in a 
different folder, change to that folder using the “Look in:” drop-down 
and then click on the file you want to import. 
 
You can open multiple files at the same time. Just highlight the first file, 
then press (Ctrl), and continue highlighting other files you want to open. 
DataCAD adds all the files you selected to the Filename field and will 
open all of them when you click on Open or press (Enter). 

4. Click Open. The DWG Import Entity Assignments dialog box appears if 
the Import section of the DXF/DWG tab of the Configure DataCAD for 
Windows Settings dialog shows that “Interactively assign . . .” is toggled 
on. The options in the DWG Import Entity Assignments dialog box allow 
you to choose how DataCAD will translate line types and fonts. 

5. Look at the options in the Line Type Assignments box; this lists each 
AutoCAD line type used in the file and suggests a DataCAD equivalent. 
To change any of these assignments, click on the line type to change. The 
line type you selected appears immediately below the Assignment list 
box with the translation line type in a drop‐down box. Choose a new line 
type from the drop‐down box; your selection appears in the preview 
window. When you click on the line type in the list box again, the name 
of the line type changes to reflect your choice. 

6. Repeat step 5 for the Font Assignments. You can specify 
DataCAD‐supplied or TrueType fonts. 
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7. Click on OK to close the dialog box and begin importing the file. Progress 
is noted in the Message toolbar. Or click on Cancel to stop the import 
process and close the dialog box. 

 
More About Importing Files Into DataCAD 
The settings and assignments that are displayed in the DWG Import Entity 
Assignments dialog box are contained in a file called TRANSFER.INI in your 
DataCAD\Support Files folder. If you change any of the settings in the DWG 
Import Entity Assignments dialog box, you have the option to save those settings 
in a new .INI file to use when translating other files. This new .INI file is saved in 
the \Support Files folder. 

You can affect how importing files and the DWG Import Entity Assignments 
dialog box work through settings on the DXF/DWG tab in the Tools/Program 
Preferences Configure DataCAD for Windows Settings dialog box. 

This could be useful if you normally exchange files with several different offices. 
If you change the settings and save a separate .INI file for each office, then you 
can easily switch between .INI files without having to go through entity 
assignments over and over again. 

 To save entity assignments: 

1. Change settings and assignments in the DWG Import Entity Assignments 
dialog box as described in the step‐by‐step instructions on importing DWG 
files. 

2. Click on Save As. The Save Settings As dialog box appears. 
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3. Type a filename for the new .INI file and click on Save, or click on Cancel 
to stop the save. When you save the .INI file, the setting for the Translator 
Settings File on the DXF/DWG tab of the Configure DataCAD for 
Windows Settings dialog box is changed to that file. 

4. Continue with step 7 (above) in the instructions for importing a DWG or 
DXF file and opening it in DataCAD. 

SketchUp File Import 
If you use SketchUp to create models, you can insert them directly or externally 
reference them in your DataCAD projects. DataCAD will automatically extract 
materials and bitmap textures from the SketchUp file and embed them into your 
DataCAD drawing. You can also convert SketchUp files to o2c format for 
raytraced views. 

 To insert a SketchUp file into your drawing: 

1. Select SketchUp from the Insert pull-down menu. The Insert SketchUp 
dialog box appears. 

2. Go to the folder that contains your SketchUp files and highlight the one 
you want to insert into your drawing. 

3. Check the boxes that you want to activate: 

• Extract textures – takes the textures that you applied in SketchUp. 

• Overwrite existing textures –places textures that you used in the 
SketchUp file into DataCAD. If you select this option, specify the 
folder where you want to store the extracted textures. 

• Extract front material(s) first – materials are extracted from front to 
back of the SketchUp drawing. 

• Preview – shows the SketchUp file. 

• Isometric – shows an isometric view of the SketchUp file. 

• Object Viewer – shows a 3D raytraced view of the SketchUp file. 

4. Click Open. The SketchUp drawing is attached (similar to the way a 
symbol is) to the cursor in your DataCAD drawing window and the Ins 
Symbol menu appears. 

5. Make decisions about the way you want the SketchUp drawing to appear 
by using the options in the Ins Symbol menu. This menu allows you to set 
the X, Y, or Z enlargement factors, dynamically rotate or explode the 
drawing, change the line factor and Z offset, toggle Fix Text to control 
legibility, and alter the symbol scale and maximum lines. 

6. Position the cursor in your DataCAD drawing window where you want 
the SketchUp drawing to appear. Then click the left mouse button. If you 
want to place additional copies of the SketchUp drawing into your 
DataCAD drawing, reposition the cursor and left-click where 
appropriate. When you are finished placing the SketchUp drawing(s), 
right-click. 
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 To insert a SketchUp file as an XREF: 

1. Select SketchUp XREF from the Insert pull-down menu. The Insert 
SketchUp dialog box appears. 

2. Go to the folder that contains your SketchUp files and highlight the one 
you want to insert as an XREF into your drawing. 

3. Click Open. The SketchUp drawing appears as an XREF box attached to 
your cursor and the Insert XREF menu appears. 

4. Make decisions about the way DataCAD should treat the SketchUp 
drawing based on the options in the Insert XREF menu. 

5. Position the cursor where you want the SketchUp drawing to appear as 
an XREF and left-click. 

The layers you create in SketchUp are retained in DataCAD when you insert the 
.skp file into your drawing. If you insert your SketchUp file as an XREF, you can 
manage the on/off layers via the Reference File Manager. If you use the Insert 
menu to add a SketchUp file to your drawing as a symbol (versus an XREF), you 
can later use the Symbol Explode command to create original layers. SketchUp 
groups and components convert to symbols in DataCAD. 

Excel Spreadsheet Import 
 To import an Excel spreadsheet into your drawing: 

1. Select Excel from the Insert pull-down menu. 

2. Select the Excel spreadsheet that you want to import from the files on 
your computer. 

3. Select Open to import the spreadsheet into your drawing. 

4. Choose the insertion point for the spreadsheet. 

SHX Fonts 
DataCAD 12 provides direct support for SHX fonts and TrueType fonts (TTF).  
DataCAD CHR fonts are no longer used.  However, your existing DataCAD 
fonts are automatically converted to SHX format. 

To convert CHR fonts to SHX format, simply add them to the DataCAD\Fonts folder, then 
run DataCAD. The program will scan this folder and convert any CHR fonts that do not 
already have an SHX equivalent. 

Productivity Enhancements 
Smart Entities 
Now you can quickly draw walls, windows, and doors in 2D, automatically 
clean up stray lines, and seamlessly convert your design into a 3D model by 
using smart entities. A smart entity is a drawing element (such as a wall, door, or 
window) that contains routines and parameters to define its characteristics and 
to determine how it interacts with other smart entities. 
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In older versions of DataCAD, when you drew two walls, they didn’t know 
anything about each other until after you joined them and cleaned their 
intersection. In DataCAD 12, walls of the same type automatically clean to each 
other, allowing you to skip the cleanup step manually. Imagine how much time 
you can save when you take advantage of smart entities. 

When you add doors and windows to a wall, DataCAD 12 automatically cuts the 
wall to accommodate them. If you move, copy, or delete a door or window from 
a wall, DataCAD 12 automatically heals the wall. 

These smart entities know what they should look like in both plan and 
perspective views. In plan view, you will see the 2D doors just as you did in 
prior versions of DataCAD. But when you switch to perspective view, you will 
see 3D doors, complete with jambs, casing, and trim. When you look at your 
model in the object viewer, you will also see the rendered materials you selected 
for the walls and other entities. 

Of course, you can still use the traditional lines and arcs to create your designs. 
You can also convert smart entities to simple entities (lines and arcs). Both 
standard and smart entities happily coexist in DataCAD 12. 

What are some of the advantages of using smart entities? 

• You can make changes quickly.  

• You can change the width of a wall and all of its intersections will update 
automatically.  

• You can change a door from double to bi-fold without removing and 
redrawing it.  

• You can copy a window from one wall to another. 

Wall, door and window type definition files are stored in folders on your hard drive.  You 
may create new wall, door and window type files, which contain the parameters that 
define how each instance of the wall, door or window will look in both 2D and 3D.  The 
external files may be loaded into your drawings, then used and modified as desired. 

If you make changes and want to use the modified type in other files, you may save out 
the definition, either overwriting the existing type file on the hard drive, or saving to a new 
name.  If you overwrite a type file on the hard drive, the changes will not be realized in 
other drawing files unless you reload the type file in those drawings. 

To delete a type file from the hard drive, open Windows Explorer (or My Computer) and 
go to the DataCAD\Support Files folder, open the appropriate Wall Type, Door Type or 
Window Type sub-folder, then delete the type file. 

Key Terms and Concepts 
To use smart entities effectively, you should learn a few new terms. Some terms 
(for example, Type) apply to walls, doors, and windows. Other terms (for 
example, Control Line) apply only to walls. 

Type refers to smart entity definitions (walls, doors, and windows) that you can 
use in your drawing. The available types of smart entities are listed on the left in 
each Manager dialog box. Many walls, doors, and windows are already defined, 
so you can quickly activate them and put them to work in your drawing. 
However, you can also customize or create your own smart wall, door, and 
window types very easily. 
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Some properties are intrinsically-linked with a particular type of smart entity 
and can only be controlled by the definition you established for it in the 
corresponding Manager. Intrinsically-linked properties are called Type-dependent. 
(For example, the width of a wall is type-dependent.)  If you change a type-
dependent property, all instances of that particular type will reflect the change. 

You can change some properties on a case-by-case basis.  These properties are 
Type-independent. (For example, the swing angle of a door is type-independent 
since you can change the angle for each smart door in your drawing, regardless 
of its type.) These properties have a default value that defines how new instances 
of the entity will appear, but the value may be changed independently on each 
instance once the entity has been added to the drawing. 

Smart Entity Glossary 
The following is a list of technical terms and their definitions which relate 
specifically to smart entites. 

Smart Entity 

A smart entity is a drawing object designed for a specific purpose, and is 
governed by a fixed set of parameters and variables. Since the object has 
internal awareness of how it should behave, it is considered to be “smart”. 
Smart entities are controlled by the user via dialogs that provide access to 
certain settings and their corresponding values. 

Type 

A “type” is a named set of settings and their corresponding values which 
define a smart entity.  Types can be saved to and loaded from external files, 
or they may be stored within a drawing file exclusively. 

Type-dependent 

Type-dependent settings are shared by all instances of a given type. 
Modifying a type-dependent setting will automatically affect all instances of 
that type. 

Type-independent 

Type-independent settings may be modified on a per-entity basis, in spite of 
their common entry in the Type Manager. 

Control Line 

A control line is specific to a smart wall and is defined by the beginning and 
ending nodes of each wall segment. All geometric aspects of a smart wall are 
defined relative to its control line. 

Node 

A node defines the end point of a wall segment and includes parameters that 
can be set by the user to determine the behavior and appearance of wall ends, 
corners, and intersections. 
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Virtual Node 

A virtual node defines the intersection of two wall segments, or the sides of a 
door or window as they relate to a wall segment.  Virtual nodes are 
automatically generated when walls on the same layer intersect, or when a 
door or window is placed in a wall. The behavior of virtual nodes is 
predefined and cannot be customized by the user.  However, virtual nodes at 
wall intersections can be converted to nodes using the X and T Intersection 
cleanup commands. 

Using Smart Walls 
Using smart walls will save you a lot of time, but understanding a few things 
will make it easy to master them:  

• Type rules how the wall looks in both 2D (Plan) and 3D (Perspective). 

• Control Line determines the reference line (or “anchor”) for a wall. 

• Node determines the look and behavior of wall ends and intersections. 

Types - Various wall types are listed in the leftmost panel of the Wall Type 
Manager. Once you load a wall type, you can activate it and use it in your 
drawing. Some wall properties (number of lines, width, and caps and openings) 
are type-dependent, so you can change them only in the Wall Type Manager – 
but not while you are drawing or editing your design. Other wall properties 
(control line) are type-independent, so you can change them while you are 
drawing.  Display / Rendering Attributes can be either type-dependent, or type-
independent (Use current settings). 

Control Line – You decide which line (outside, center, inside, line 2, or line 3 
options are available, depending on the wall type you loaded) you want to use 
when you are drawing your structure. The control line is type-independent, so 
you can change it when necessary while you are drawing. 

Node – At intersections and wall ends, nodes influence how two wall surfaces 
interact as far as cleaning, moving, and stretching are concerned. DataCAD 
automatically inserts nodes (indicated by an X) when you start or end a wall or 
when you make a corner. Virtual nodes (indicated by an open diamond) are 
automatically inserted when two walls cross (for example, at an X intersection) 
or when you place a smart door or window on a wall. You can use the Edit Walls 
option in the Architect menu (with Auto 3D enabled) to add nodes to smart 
walls. You can also use the Weld Wall and Weld Line commands in the Cleanup 
menu to remove nodes from smart walls. 

Before you set up your drawing, there is one important fact to remember: smart 
walls must all be on the same layer if you want them to clean to each other. That 
means exterior walls will not clean to interior walls if they are on different layers. 
Doors and windows do not have to be on the same layer as walls (for example, 
walls can be on Layer 1 and windows on Layer 2). 

 To create walls: 

1. Make sure you are on the layer that contains your walls. This assures that 
the walls will be able to clean properly. 

2. Go to the Edit menu in the Menu Window and select Architect. 
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3. Toggle on Auto 3D in the Architect menu. The Walls menu appears. This 
allows you to work with the smart entities. If Auto 3D is toggled off, you 
can draw walls the old-fashioned way. 

    
4. Select Manage to display the Wall Type Manager dialog box. Notice that 

the default is a 2-line wall suitable for an interior wall. If this is what you 
want, just select OK and begin drawing walls. Otherwise, make sure a 
checkmark appears in the Display External Types box and continue to 
refine your choices. 
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5. Select the wall type you would like to use instead of the default by 
double-clicking or by highlighting it and clicking on Load. Notice that 
when you make a selection, the illustration in the preview window and 
the wall and line properties change.  

6. Refine the wall and line properties by using the options in the Wall 
Properties, Caps and Openings, and Line Properties sections of the Wall 
Type Manager.  

• Number of lines – select from the pull-down options (2, 3, or 4) to 
indicate how many lines will appear in the 2D drawing. 

• Control Line – select from the pull-down options (Outside, Center, 
Inside, Line 2, or Line 3) to indicate which line is dominant when you 
are drawing. 

• Caps inherit line properties from – select Inside Wall or Outside Wall. 
(This option is available for 2-line walls only. On 3- and 4-line walls, 
material is applied from the outside line to the next one in and from 
the inside line to the next one in.) 

• Openings inherit line properties from – select Inside Wall or Outside 
Wall. (This option is available for 2-line walls only. On 3- and 4-line 
walls, material is applied from the outside line to the next one in and 
from the inside line to the next one in.) 

When you use a 3- or 4-line smart wall, the material extends from the outside 
face to the next line on the interior of the wall and from the inside face to the 
second line from the outside wall. 
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• Line – select the line number you want to describe and then make 
offset and display/rendering attributes choices to control how each 
line will appear in your drawing. If you are not satisfied with your 
choices, click Revert. When you want to test your choices for each 
line, decide which field you want to be active, then click Apply and 
look at the results in the preview window.  

• Offset from previous line – use this option to indicate the width of a 2-
line wall or to show the offset for 3- or 4-line walls. Changing the 
offset values, affects the overall Width shown in the Wall Properties 
section. Do this for each line except line 1. 

• Use current settings – controls your ability to change 
display/rendering attributes. If you want to make changes to the 
color, line type, pen style, and material defaults supplied by 
DataCAD, click to remove the checkmark from this box. 

• Color – select the line’s color from the pull-down options. Do this for 
each line. 

• Weight – control the line’s weight for the 2D drawing. Do this for each 
line. 

• Line Type – select the line’s appearance (Solid, Dotted, Dashed, Dot-
Dash, or -dash-) for the 2D drawing. Change the value in the Spacing 
field to control the line. Do this for each line. 

• Pen Style – select the option you want from the pull-down menu and 
indicate a Spacing value. Do this for each line. This scale-independent 
feature always appears and prints in one size. 

• Material – select an option from the pull-down menu to describe the 
material associated with each line. If you are not satisfied with the 
available materials, click Load to display the Load Material File dialog 
box, highlight the option you want, click Open to add that material to 
the list of available materials, then select it from the pull-down menu. 
Do this for each line. 

7. Make sure you are satisfied with your choices for each line of the wall, 
click Save or Save As, name the wall type in the dialog box that appears, 
and click Save. Your new wall type appears in the Wall Type Manager 
list.  

What’s the difference between Save and Save As? When you select Save, the 
changes you made are stored on the hard disk in place of the original file. That 
means the original file no longer exists because you wrote over it with your 
changes. When you select Save As, you supply a new name for the changes you 
made to the original. That means the original file still exists and the new file you 
just named contains your customized version. 

8. Highlight a wall from the list and select Set Active to indicate which type 
of wall you want to draw. Then select OK and begin to draw the wall. 
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 To quickly access the Wall Type Manager: 

Press A to display the Architect toolbar, toggle Auto 3D on in the Walls 
menu, and select S from the Architect toolbar or Manage from the Walls 
menu to open the Wall Type Manager. If Auto 3D is toggled off in the 
Walls menu and you select S from the Architect toolbar, the old Wall 
Style Manager dialog box appears. 

 
Or select the first button in the Types toolbar. 

 

 To create your own smart wall type: 

1. Select New in the Wall Type Manager. 

2. Enter a distinctive name in the New Wall Type dialog box and select OK. 

3. Highlight the name in the Wall Type Manager’s list and define the wall 
and line properties. 

4. Select Set Active. Then select OK to exit the Wall Type Manager and 
begin using it in your drawing. 

 To draw with smart walls: 

1. Highlight the wall you want to use in the Wall Type Manager, select Set 
Active, and select OK to exit to the drawing window. 

2. Activate Walls in the Walls menu. 

3. Decide which options you want to use in the Walls menu: 

• Trim Out – trims wall segments by the outermost line. If you activate 
this option, you cannot use Trim In. This option is available only 
when Clean is activated and Cap is not. 

• Trim In – trims wall segments by the innermost line. If you activate 
this option, you cannot use Trim Out. This option is available only 
when Clean is activated and Cap is not. 

• Clean – automatically cleans wall intersections. 

Shortcut: Press the \ key to toggle Clean on while creating a smart wall. 

• Cap – places a cap at the beginning and ending of each wall segment. 

Shortcut: Press Shift-\ to toggle Cap on while creating a smart wall. 

If you activate both Cap and Clean, the beginning of the wall is capped, the 
linked segments are cleaned, and the ending segment is capped. 

4. Draw your walls. 
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 To quickly access activated smart wall types: 

1. Make sure the Types toolbar is displayed. If it isn’t, select Toolbars from 
the View pull-down menu, check the Types box, and click OK. 

2. Select the wall type that you want to use from the Wall pull-down list on 
the Types toolbar. 

 To edit smart walls: 

1. Activate Edit Walls in the Walls menu. 

2. Decide which function(s) you want to use on a particular wall segment: 

• Add Node – lets you add segments to an existing wall. Just click near 
the wall where you want to add the node, then drag your mouse and 
click to establish the position of the new node. 

• Poly to Wall – converts existing polyline edges into wall segments. 

• Swap In/Out – lets you swap the outside wall line with the inside and 
vice versa. This is easiest to see when the outside and inside wall lines 
are different colors. 

3. Activate the function(s) you want to use, then follow the prompts shown 
on the Message toolbar. 

 To add an adjoining wall to your drawing: 

1. Press [A] to display the Walls menu and make sure Auto 3D is on. 

2. Toggle on Clean and either Trim Out or Trim In (depending on the way 
you want to trim your walls). 

3. Open the Wall Type Manager, highlight the wall you want to use, select 
Set Active, and select OK. 

4. Draw the additional walls, starting at one of the existing smart walls. 

 To cut an opening in a smart wall: 

1. Press [A] to display the Walls menu and make sure Auto 3D is on. 

2. Select Cut Wall to display the Openings menu. 

3. Select the Layer that contains the wall you want to cut. 

4. Toggle Cap on if you want to cap each end of the cut. 

5. Select the wall where you want the cut to begin; then select the wall 
where you want it to end. If you toggled Cap on, each end is capped. 

 To change a smart wall’s base elevation (Z-Base), height elevation (Z-Height), 
and overall height: 

1. Go to the Change menu by pressing [Alt] + [C]. 

2. Toggle on Z-Base, type a different value in the insert field, and press 
[Enter]. 
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If you change only the Z-Base of a smart wall, the bottom of the wall will move to 
the specified Z-Base. The top of the wall will be determined by the wall’s height 
property. For example, if the original Z-Base was 0 and the Z-Height was 8, the 
wall was 8 feet high. By changing the Z-Base alone to 4, the wall would still be 8 
feet high, making the top reach a height of 12. 

3. Toggle on Z-Height, type a different value in the insert field, and press 
[Enter]. 

If you change only the Z-Height or a smart wall, the top of the wall will move to 
the specified Z-Height. The base of the wall will be determined by the wall’s 
height property. For example, if the original Z-Base was 0 and the Z-Height was 
8, the wall was 8 feet high. By changing the Z-Height alone to 6, the wall would 
still be 8 feet high, making the base extend down to -2 feet. 

If you change both the Z-Base and Z-Height in the same operation, both the top 
and bottom of the smart wall will change. For example, if the original Z-Base was 
0 and the Z-Height was 8, the wall was 8 feet high. By changing the Z-Base to 6 
and the Z-Height to 16, the wall would now be 10 feet high. 

 To switch between drawing smart walls and regular lines: 

1. Draw the smart walls. 

2. Press the [=] key on the keyboard and draw using regular lines. 

3. Press the [=] key on the keyboard again and return to drawing smart 
walls. 

When you are entering smart walls and have the Walls menu displayed, 
snapping works like this: 

• If Clean is activated, Pick or Snap projects the node point to the control line of 
the intersecting wall and cleans the intersection. 

• If Clean is off, Pick or Snap places the node point at the selected point and 
does not clean the intersection. 

Using Smart Doors 
Of course, smart walls are fun to draw, but installing smart doors is even easier. 
You simply activate doors that you want to use in your drawing and then place 
them into the smart walls. 

 To activate doors for insertion into smart walls: 

1. Select the middle button on the Types toolbar to open the Door Type 
Manager dialog box. Alternatively, you can Press [A] to display the Walls 
menu, make sure Auto 3D is highlighted, select Doors to display the 
Doors menu, and select Manage.  

Notice that the Door Type Manager has multiple tabs. This gives you more 
control over the components of the doors you include in your drawings. Each tab 
offers different display/rendering attributes that you may be able to change. 
Options that you cannot change are grayed out. 

2. Select the door type you would like to use instead of the default by 
double-clicking or by highlighting it and clicking on Load. Notice that 
when you make a selection, the illustration in the preview window and 
the door and line properties change. 
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3. Refine the door properties by using the options in the various tab sections 

of the Door Type Manager.  

For most of the tab sections, you can change the display/rendering attributes to 
customize the doors for your drawing. Your alterations appear in the preview 
window when you change the focus to the next field. 

• Unit – you can change the unit type (single, double, bi-fold, double bi-
fold, sliding, pocket, and overhead) in addition to head and sill 
heights.  

• Trim Out and Trim In – you can control the exterior and interior trim 
by specifying head and jamb width and thickness as well as head 
extension. 

• Header – based on the options you checked, you can change the 
header’s thickness, depth, and offset from the wall. 

• Jamb – based on the options you checked, you can change the jamb’s 
thickness, depth, and offset characteristics. 

• Sill – if Include is checked, you can control the sill’s thickness and its 
inside, outside, and side extensions. 

• Stop – if Include is checked, you can control the stop’s thickness and 
width. 
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• Door – toggle Include on to display the door in both 2D and 3D views. 
A parametric door will be drawn for both. If you check Use Symbol in 
the 2D section, you can select a symbol that will be displayed in 2D 
views in place of the Trim In, Trim Out, Header, Sill, Stop, and Knob. 
If Include Parametric Door is not checked, it will also include the 
Door and Swing. If Include Parametric Door is checked, you do not 
need to include the Door or Swing in your 2D symbol because they 
will be drawn parametrically. Make sure the symbol you create has 
the correct depth to match the wall’s width, is wide enough to match 
the opening’s width, and has the insertion point at the lower left 
outside corner of the wall opening. When Flush is checked, the door is 
flush with the wall opening; if it is not checked, you can enter an 
Offset value. When Use Symbol 3D is checked, you select a 3D symbol 
to use in place of the parametric door for 3D views. 

• Knob – if Include is checked, you can control the appearance and 
position of the inside and outside door knobs. If you check Use 
Symbol and select a specific knob, you cannot change its diameter and 
extension.  

• Swing – use this tab to describe the way the door’s swing should 
appear in both 2D and 3D versions, including swing type, color, and 
angle. If you do not check Match Door Color, you can specify any 
color for the 2D swing arc or line. The Swing Angle for both 2D and 
3D are applied to the door when the door is inserted. Once the door is 
created, they become a property of the door entity, not the door type. 
To change them after you created a door, you must change the 
property of each door with the Entity Properties Editor. 

4. Select Apply to finalize your choices; then select OK if you want to use 
this door in your drawing without changing the basic description in the 
file.  

If you want to use this door with all the attributes you changed in future drawings, 
select Save As. Give the door a distinctive file name and select Save in the Enter 
door type filename dialog box. Whenever you want to use it later, just select it 
from the list that appears in the Door Type Manager, activate it, and insert it in 
future drawings. 

Caution: If you select Save, your changes will overwrite the original door file. 

 To insert a smart door into your drawing from the Door Type Manager: 

1. Highlight the door that you want to use from the ones you loaded into 
the Door Type Manager. 

2. Click on Set Active and then select OK to close the Door Type Manager. 
Notice that the active door’s name is red and the inactive ones that you 
loaded are black. 

3. Make decisions about how you want to place the smart door into your 
drawing: 

• Toggle Sides on in the Doors menu if you want to place the smart 
door by sides. You are prompted to Click hinge side of door. 
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• Toggle Sides off in the Doors menu if you want to place the smart 
door by its center. You are prompted to Click center of door. 

• Toggle Center Point on to add a snapping point to the center of the 
door. 

• Toggle Cut Wall on to automatically remove the smart wall where 
you place the smart door. 

• Anchor the door by its sill or head. Toggle At Sill on to anchor the 
door by its sill. Toggle At Sill off to anchor the door by its head. 

• Decide which layer you want to search for walls. Toggle One Layer 
on if you want to search only one layer.  Toggle One Layer off if you 
want to search more than one layer. If you toggle One Layer off, 
another option appears on the Doors menu to allow you to toggle on 
Any Layer if you want to search all the “on” layers for smart walls 
where you can place the door. 

4. Select the point on the smart wall where you want to install the door. You 
are prompted to Click strike side of door and indicate direction of door swing. 

5. Click to indicate the way the door should open. 

6. Continue placing copies of that door into your drawing where needed. 

7. Place other smart doors that you loaded in the Door Type Manager by 
selecting them from the pull-down menu in the Types toolbar. 

 To replace one smart door with another: 

1. Select Search/Repl. from the Doors menu. The Search and Replace dialog 
box appears. 

If you select Search and Replace from the Edit pull-down menu, select Door 
types from the Type pull-down menu in the Search and Replace dialog box. 

 
2. Select the door type you want to eliminate from the ones available in the 

Find pull-down menu. Only loaded smart doors are available. 

3. Select the door type you want to take the place of those you indicated in 
step 2. Only loaded smart doors are available. 

4. Click OK. The Search/Repl. menu appears. 

5. Toggle on the search parameter you want to use:  

• Entity – lets you replace the doors you select on a case-by-case basis, 
leaving the other ones as you originally indicated. 
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• Group – automatically replaces all of the doors at once. 

• Area – prompts you to place a rubber band around the rectangular 
area where the doors need to be changed. Doors outside the area you 
indicated will not change. 

• Fence – prompts you to create a rubber band around the polygon-
shaped area where the doors need to be changed. Doors outside the 
fence you indicated will not change. 

• Mask – lets you search for specific entities based on their properties. 

• Replace All – provides the ability to replace all entities on “On” 
layers.  

 To change a smart door’s Z-Base, Z-Height, and door height: 

1. Go to the Change menu by pressing (Alt-C). 

2. Determine which option (At Sill or At Head) was used when the door 
was created: 

• If At Head was toggled off, select Z-Base. This is the only way to 
affect the door’s z-position. Selecting Z-Height will do nothing. 

• If At Head was toggled on, select Z-Height. This is the only way to 
affect the door’s position. Selecting Z-Base will do nothing. 

Using Smart Windows 
Installing smart windows is much like smart doors. You simply activate 
windows that you want to use in your drawing and then place them into the 
smart walls. 

 To activate windows for insertion into smart walls: 

1. Select the rightmost button on the Types toolbar to open the Window 
Type Manager dialog box. Alternatively, you can Press A to display the 
Walls menu, make sure Auto 3D is activated, select Windows to display 
the Windows menu, and select Manage.  

Notice that the Window Type Manager has multiple tabs. This gives you more 
control over the components of the windows you include in your drawings. Each 
tab offers different display/rendering attributes that you may be able to change. 
Options that you cannot change are grayed out. 

2. Select the window type you would like to use instead of the default by 
double-clicking or by highlighting it and clicking on Load. Notice that 
when you make a selection, the illustration in the preview window and 
the window and line properties change. 
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3. Refine the window properties by using the options in the various tab 
sections of the Window Type Manager.  

For most of the tab sections, you can change the display/rendering attributes to 
customize the windows for your drawing. The changes are displayed when you 
change focus to another field. 

• Unit – you can change the unit type (fixed, casement, awning, hopper, 
double-hung, sliding), quantity, plus head and sill heights.  

• Trim Out and Trim In – you can control the exterior and interior trim 
by specifying head, jamb, and sill width and thickness as well as head 
and sill extension. 

• Header – based on the options you check, you can change the 
header’s thickness, depth, and offset from the wall. 

• Jambs – based on the options you check, you can change the jamb’s 
thickness, depth, and offset characteristics. 

• Sill – if Include Sill is checked, you can control the sill’s thickness and 
its inside, outside, and side extensions. 

• Sash – if Include Sash is checked, you can control its thickness, width, 
and offset. The Use 3D Symbol option lets you use a 3D symbol to 
represent your window in 3D views instead of the parametric 
window. The % Open 3D setting defines the percentage that the 
window is open in 3D views. This setting is applied to each window 
when you place it in your drawing; however, it is a property of the 
window entity, not its type. To change the percent opening after 
adding a window to your drawing, use the window Entity Properties 
Editor. For casement or hopper windows, you can check Opens 
Inward. 

• Muntins – if Include Muntins is not checked, the window is plain. If 
the Include Muntins, Centered, and Use Slabs are checked, you can 
control their thickness, offset, and width. On the window’s edges, you 
can use the full-width or half-width muntins. Alternatively, the edge 
can contain no muntins if you select None. 
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• Glass – if Include Glass is checked, you can control the thickness of 
the window, its offset position, and the number of horizontal and 
vertical panes. Depending on the Unit Type, options for Upper and 
Lower panes are available separately. If you check Centered, the 
Offset option is unavailable.  

• 2D Options – you can specify a symbol to use in place of the Sill, Sash, 
and Glass, or any combination of the three in 2D views of your 
drawing. Remember that the depth of the symbol must match the 
width of your wall; the width of the symbol must match the width of 
your opening. The Unit Width will be defined by the width of the 
symbol you select. 

4. Select Apply to finalize your choices; then select OK if you want to use 
this window in your drawing without changing the basic description in 
the file.  

If you want to use this window with all the attributes you changed in future 
drawings, select Save As. Give the window a distinctive file name and select 
Save in the Enter window type filename dialog box. Whenever you want to use it 
later, just select it from the list that appears in the Window Type Manager, 
activate it, and insert it in future drawings. 

 To insert the window into your drawing. 

1. Make sure the Walls menu is displayed (if it isn’t, press A) and select 
Windows.  

2. Decide which smart window you want to use. Either go to the Window 
Type Manager, highlight the loaded window you want, click Set Active, 
and select OK to exit the dialog box. Or select the window you want from 
the pull-down options available on the Types toolbar. The Windows 
menu appears. 

3. Make decisions about how you want to place the smart window into your 
drawing: 

• Toggle on Sides if you want to place the smart window by its sides. 
You are prompted to Click one jamb of window to pick where the first 
side should go; then you are prompted to Click second jamb of 
window for the other side. 

• Toggle Sides off if you want to place the smart window by its center 
point. You are prompted to Click center of window. 

• Toggle on Center Point to automatically add a snapping point to the 
center of the window. 

• Toggle Cutout on to automatically remove the smart wall where you 
place the smart window. 

• Anchor the window by its sill or head. Toggle At Sill on to anchor the 
window by its sill. Toggle At Sill off to anchor the window by its 
head. 
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• Decide which layer you want to use. Toggle One Layer on if you want 
to search only one layer.  Toggle One Layer off if you want to search 
more than one layer. If you toggle One Layer off, another option 
appears on the Windows menu to allow you to toggle on Any Layer if 
you want to search all the “on” layers for smart walls where you can 
place the window. 

5. Select the point on the smart wall where you want to install the window. 

6. Continue placing copies of that window into your drawing where 
needed. 

7. Place other smart windows that you loaded in the Door Type Manager by 
selecting them from the pull-down menu in the Types toolbar. 

 To replace one smart window with another: 

1. Select Search/Repl. from the Windows menu. The Search and Replace 
dialog box appears. 

If you select Search and Replace from the Edit pull-down menu, select Window 
types from the Type pull-down menu in the Search and Replace dialog box. 

 
2. Select the window type you want to eliminate from the ones available in 

the Find pull-down menu. Only loaded smart windows are available. 

3. Select the window type you want to take the place of those you indicated 
in step 2. Only loaded smart windows are available. 

4. Click OK. The Search/Repl. menu appears. 

5. Toggle on the search parameter you want to use:  

• Entity – lets you replace the windows you select on a case-by-case 
basis, leaving the other ones as you originally indicated. 

• Group – automatically replaces all of the windows at once. 

• Area – prompts you to place a rubber band around the rectangular 
area where the windows need to be changed. Windows outside the 
area you indicated will not change. 

• Fence – prompts you to create a rubber band around the polygon-
shaped area where the windows need to be changed. Windows 
outside the fence you indicated will not change. 

• Mask – lets you search for specific entities by their properties. 
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• Replace All – provides the ability to replace all entities on “On” 
layers.  

 To change a smart window’s Z-Base, Z-Height, and window height: 

1. Go to the Change menu by pressing [Alt] + [C]. 

2. Determine which option (At Sill or At Head) was used when the window 
was created: 

• If At Head was toggled off, select Z-Base. This is the only way to 
affect the window’s z-position. Selecting Z-Height will do nothing. 

• If At Head was toggled on, select Z-Height. This is the only way to 
affect the window’s position. Selecting Z-Base will do nothing. 

Hint: Switching to an elevation view and using 3D Move is another way to 
accomplish this. 

Search and Replace 
You can quickly replace smart walls, smart doors, smart windows, and materials 
by using this handy feature. 

 To replace one activated smart entity or material with another: 

1. Select Search and Replace from the Edit pull-down menu. The Search and 
Replace dialog box appears. 

2. Use the options in the pull-down field to indicate what you want to find 
in your drawing and what you want to replace it with: 

• Type - choose one option from Wall types, Door types, window 
Types, or Materials. 

• Find – select what you want to eliminate from a list of the smart 
entities or materials activated in your drawing. 

• Replace – select what you want to replace it with from a list of the 
smart entities or materials activated in your drawing. 

You cannot access smart entities or materials that you did not use in your 
drawing. For example, you can replace smart window CXW 145 with CXW245 
since both were already loaded within your drawing; however, you cannot replace 
it with C24 if you had not previously loaded it within the Window Type Manager. 
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3. Select OK. Select the entities to replace by using the standard selection 
menu or choose Replace All to replace all instances of the smart entity in 
your drawing. 

Object Snapping 
The enhancements make object snapping faster and easier to use. This faster 
response time is particularly helpful in larger drawings. You can now snap 
between and within symbols and XREFs (including nested levels). Also you can 
snap to polyline bulge centers and XClip boundaries. 

The dynamic snap indicator automatically displays available object snap 
locations in real-time, based on your object snap settings. 

The Object Snap menu (accessed by typing Shift-X or selecting Object Snap from 
the Utility menu) has changed: 

• No. Divisions – (replaces No. Points) allows you to search for a specified 
number of divisions. 

• Offset – lets you snap to a specific offset from the endpoint or midpoint. Use 
Offset Dist to define the offset distance. For example, setting and Offset Dist 
of 0.4 will enable object snapping to points four inches from endpoints and 
midpoints. 

• More Options – leads to a submenu that contains some of the options that 
were moved from previous versions of the Object Snap menu: Fast Symbol, 
Fast 3D, Quick, and Sel. Set. 

3D Boolean Operations 
This addition allows you to combine, intersect, and subtract portions of 3D 
entities in your drawing. You can access these operations via the 3D Edit or the 
Create pull-down menus. 

 To use 3D Boolean operations: 

1. Select Boolean 3D from the 3D Edit menu or select Boolean 3D from the 
Create pull-down menu. The main Boolean 3D menu appears. You are 
prompted to Select first object. 

2. Select a 3D object in your drawing. The secondary Boolean 3D menu 
appears. You are prompted to Select second object. 

3. Select the operation (these are mutually exclusive options) you want to 
perform: 

• Combine – merges (or adds together) two or more 3D objects. 

• Intersect – shows the portion where two or more 3D objects overlap. 

• Subtract – eliminates parts of 3D objects. 

4. Select the second 3D entity to interact with the first one. Toggle Multiple 
on if you want to select more than one entity. At this point, DataCAD will 
make the necessary calculations and create a symbol which contains the 
3D geometry defined by the Boolean operation. 
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5. Change the enlargement, rotation, offset, or scale of the resultant object if 
necessary based on the options available in the Ins Symbol menu. 

6. Position the symbol box where you want the results of the 3D Boolean 
operation to appear in your drawing. 

Edit Planes 
You can recall construction planes on a per-entity basis. 

 To change your current view projection to match the edit planes of a 3D 
entity in your drawing: 

1. Press and hold [Ctrl] while you hover your cursor over the entity.  

2. Right-click to access the context menu 

3. Choose Get Construction Plane. 

Multi-line Text 
Now you can format multi-line text. It features wrap-around text boundaries and 
the ability to format the font, size, amendments (bold, italic, underline, 
overstrike, and color), alignment, and line spacing factor. Multi-line text is based 
on RTF (Rich Text Formatting) and is compatible with AutoCAD’s MText. 

 To use multi-line text: 

1. Highlight Text in the Create pull-down menu, drag your cursor to the 
right, and select MText from the submenu. Alternatively, you press Alt-T 
to access the Text menu and select MText. The Text menu appears and 
you are prompted to Enter 1st point of paragraph text. 

2. Select features you want to modify in Text menu: 

• Margins – sets the distance between the text and the boundary. 

• Boundary – displays a boundary line around the text if you toggle this 
option on. If you toggled Boundary on, a Box Property button 
becomes available, allowing you to control the line type and weight, 
color, spacing overshoot, pen style, and spacing of the boundary box. 
Also, the Print toggle lets you enable (on) or disable (off) printing of 
the boundary box. 

• Word Wrap – wraps text within the boundary when toggled on. 

• Line Spacing – lets you select the amount of space between lines of 
text. 

• Alignment – defines the text alignment properties (left, right, or 
center). 

• Angle – defines the rotation angle of the text. 

3. Point in your drawing where you want to place the text and click. This 
serves as an anchor point. The Edit Multiline Text dialog box appears. 

4. Type the text in the dialog box and format it before placing it in your 
drawing. 
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• Select the font you want for various parts of your text from the pull-
down menu. 

• Select the font size from the pull-down box or enter a new size. 

• Highlight portions of your text and use the B (bold), I (italics), U 
(underscore), or O (overstrike) buttons to add emphasis. 

• Change the color of portions of your text by highlighting the word or 
phrase, clicking on the button beside O, picking the color you prefer 
from the Color Palette, and selecting OK. 

• Select text position (Bottom, Center, or Top) from the pull-down 
menu. 

5. Select OK to place the text into your drawing. You are prompted to Enter 
point to calculate text wrapping width.  

6. Move the cursor about to position the block of text. Click when you are 
satisfied with the way it looks. 

Font Dialog Enhancements 
Several additions to the Font (formerly, Set Text Parameters) dialog box make it 
easier to define the font and its characteristics. Characteristics that were once 
controlled via the Font menu are now included in the Font dialog box, including 
height (size), aspect, slant, weight, line factor (line spacing), text scale, and all 
caps. Perhaps the most useful new feature is the ability to create, save, and load 
text styles. 

 To control font characteristics: 

1. Point to Text in the Create pull-down menu, slide your cursor to the right, 

and select Text from the submenu. Alternatively, select   from the 
Icon I Draw toolbar or press Alt-T. The Text menu appears. 

2. Select Font from the Text menu to open the Font dialog box. 
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3. Define the font’s characteristics by selecting from pull-down menus, 
entering measurements in fields, and checking boxes. The results of your 
decisions appear in the Preview window. 

• Font Format(s) – check the types of fonts (TTF, SHX, or All) you want 
to have available in the Font List.  

The CHR fonts from previous DataCAD versions are no longer used. DataCAD 
12 automatically converts all existing CHR fonts to SHX format. 

• Font List – select the font you want to use. 

• Height, Aspect, Slant, and Weight – enter values into the fields. 

• Style – select regular, bold, italic, or bold italic from the pull-down 
menu. 

• TrueType Fill/Outline – define the fill and outline colors. If you check 
Fill with current color or Outline with current color, DataCAD uses 
the active layer’s color for the text. If you want to select your own fill 
and outline colors, click on the color swatch and pick from the Color 
Palette options. 

• All Caps – turns all text you type to uppercase if checked. 

• Text Scale – sets text size relative to current print/plot scale if 
checked. 

• Text Styles – select from available styles. 

• Sample text – type in the input field within the Preview window. 
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4. Select OK when you are satisfied with your font decisions. When you 
return to the Drawing window, the cursor changes to a text tool so that 
you can begin typing information. 

 To create and use text styles: 

1. Define font characteristics. 

2. Select Text Styles options: 

 
• Add – allows you to name your text style. Just type the style’s name 

in the input field and select OK. 

• Delete – lets you eliminate a text style. Display the style name, select 
the Delete button, and select Yes in the Confirm dialog box. 

• Update – lets you change a text style’s characteristics. Display the 
style name, make changes to the font’s characteristics, and select the 
Update button. 

• Copy – copies text style settings to the Windows clipboard. This lets 
you use the text styles you created in another drawing file. 

• Paste – pastes text style settings from the clipboard. This lets you 
retrieve text styles you placed on the Windows clipboard via the 
Copy button from another drawing file and insert them into the 
current one. 

3. Display the text style you want to use in the pull-down Text Styles box. 

4. Select OK to exit the Font dialog box, position the font cursor in your 
drawing, and begin typing text. 

Entity Properties Editor 
You can access the properties of any entity in your drawing, change them, and 
apply the results immediately. The preview window lets you see how your 
changes affect three-dimensional entities. 

 To control an entity’s properties: 

1. Place your cursor on an entity in your drawing. Then hold down the Ctrl 
key and simultaneously right-click (Ctrl-right click). 

2. Select Properties from the pop-up menu. This displays the Properties 
dialog box and the Preview window. 
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3. Define the entity’s properties: 

• Preview options – use Display 3D Preview, Include Ground Plane, 
and Render by Color boxes to determine the way the object appears in 
the Preview window. 

• Layer – select the layer that contains the object. 

• Color – select the color of the line that will appear in your drawing. 

• Line Type and Spacing – set the way the line will be drawn. 

• Pen Style, Spacing, Line Weight, and Overshoot – set Pen Style for 
display. 

• Material – select from materials you defined previously. 

4. Select Apply to view the results in your drawing as well as the Preview 
window. If necessary, you can refine your decisions by making changes 
in the definition fields. 
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5. Select OK when you are satisfied with the results. 

Rendering Settings for o2c 
You can assign material definitions on a per entity basis. All of these material 
definitions are embedded in your drawing. This lets you apply the same material 
to multiple entities in your drawing. 

 To assign defined materials to other entities in your drawing: 

1. Place your cursor on an entity in your drawing. Then hold down the Ctrl 
key and simultaneously right-click ([Ctrl] + right-click). 

2. Select Material by Entity from the pop-up menu. This displays the 
Material Assignment (Entity) dialog box. It contains the embedded 
materials settings you created for individual entities in your drawing in 
the Drawing Materials pull-down menu. 

3. Select the material definition you want to use and pick OK to exit to your 
drawing. 

4. Display the model in the object viewer. DataCAD applies the material to 
the object you selected in step 1. 

Symbol Enhancements 
You can edit unexploded symbols on the fly. You can save these changes to the 
current drawing only and/or to your hard disk. Also, you can save the changes 
to a new symbol definition. 

 To edit an unexploded symbol in your drawing: 

1. Place your cursor on the symbol and press Ctrl-right click to expose the 
pop-up menu. 

2. Select Symbol Tools, slide your cursor to the right to see the submenu, 
and pick Edit Symbol. The symbol you selected appears along with the 
Edit menu. 

3. Make changes to the symbol.  

4. Select Save As from the File pull-down menu. Supply a new file name 
and select Save to store the edited symbol to your hard drive. To 
overwrite the symbol definition on the hard drive, you must first save the 
changes to the symbol in the current drawing. Next, click the folder icon 
on the Symbol Browser and choose “Drawing” to browse symbols in the 
current drawing. Locate the revised symbol, right-click on it and choose 
“Save As,” then choose the existing file to overwrite. 

Textures, Backgrounds, Hatch Patterns 
Seamless textures and backgrounds are available to add realism to your 
renderings. Both textures for various materials and backgrounds are found in the 
Textures folders. 

Many new hatch patterns are located in Support Files in the Hatch Patterns 
folder. 
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Dimension Enhancements 
You can assign a unique scale type to any associative dimension. This allows you 
to maintain multiple dimensioning formats within the same drawing. 

 To assign a unique scale type to different parts in a drawing: 

1. Select Dimensions from the Utility menu or press D to display the 
Dimensions menu. 

2. Select Linear.  

3. Select Lock Scale. 

4. Choose the measurement scale type (Drawing, Arch., Eng., Decimal, etc.) 
you want to use to dimension something in your drawing. Right-click to 
return to the previous menu. 

5. Toggle on the placement option (Horizontal, Vertical, Aligned, or 
Rotated) you want to use. 

6. Object snap to the first point of the distance you want to dimension. 

7. Object snap to the second point of the distance you want to dimension. 

8. Pull the dimension line and click when you are satisfied with its position. 
If DataCAD cannot automatically position the dimension measurement, 
you can place it where it will fit on your drawing. 

In the following example, Lock Scale allowed us to use different scale types to 
dimension selected edges of closed polylines. 
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Clipping Changes 
You can clip symbols using either rectangular or irregularly shaped polyline 
boundaries. 

 To use an irregular polyline to clip a symbol: 

1. Select Clip Cube from the 3D Views menu. Alternatively, click on the Clip 
Cube icon in the Viewer toolbar. 

2. Select Symbol Clip from the Clip Cube menu. The SClip menu is blank. 

3. Select the symbol in your drawing that you want to clip. The SClip menu 
contains options. 

4. Select New Cube. The New Cube menu appears. 

5. Select Polyline and draw the shape you want by extending the polyline 
and clicking where appropriate. When the polyline meets your wishes, 
right-click to end the clip. 

6. Toggle Clip On in the SClip menu to display the results in your drawing 
window. 

 To use an irregular polyline boundary to clip an XREF: 

1. Insert an XREF into your drawing. 
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2. Select Clip Cube from the 3D Views menu. Alternatively, click on the Clip 
Cube icon in the Viewer toolbar. 

3. Select XREF Clip from the Clip Cube menu. The XClip menu is blank. 

4. Select the XREF in your drawing that you want to clip. The XClip menu 
contains options. 

5. Select New Cube. The New Cube menu appears. 

6. Select Polyline and draw the shape you want by extending the polyline 
and clicking where appropriate. When the polyline meets your wishes, 
right-click to end the clip. 

7. Toggle Clip On in the XClip menu to display the results in your drawing 
window. 

Pen Styles/Pen Widths 
Based on the Windows line type format, you can apply scale-independent 
patterns to your DataCAD line types. These patterns are compatible with the 
Windows Metafile format and convert directly to Adobe PDF format. This allows 
you to apply non-standard patterns such as a property line to curves. 

New Toolbars 
The Notate and Types toolbars are helpful additions that can speed up the 
drawing process. 

 

 
 To control the scale of notations: 

1. Display the Notate toolbar. 

2. Open the Set symbol scale pull-down menu on the toolbar. 

3. Select the scale option that you want to use. 

 To add and control notations in your plots: 

1. Select the option you want to use from the Notate toolbar.  

2. Point where you want that notation to appear. Then click. For many 
options, the Edit/Customize definition box appears. 
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3. Supply information in the Value fields. Select OK when you are finished. 

The notation is added to your plot. 

The Types toolbar lets you quickly manage and use the smart walls, doors, and 
windows. 

 
 

Plotting Enhancements 
You can save your current plotter and Quick Layout settings to a file that you 
can load into other drawings. Also, you can assign unique pen tables to specific 
scales. This means that large-scale drawings and details can have thicker pens 
and small-scale drawings can have thinner ones. You can assign unique pen 
tables to specific multi-scale plotting details. 

 To assign pen tables to specific scales: 

1. Select Scale to Pen in the Print/Plot menu to display the Pen Table 
Assignments dialog box. 

2. Click in the appropriate Uses this Pen Table field. 

3. Open the Load pen file dialog box by clicking on the three-dot button that 
appears at the end of the field you selected. 

4. Select the pen file you want to use for that scale and click Open. 
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 To assign unique pen tables to specific multi-scale plotting details: 

1. Select Multi-layout from the Print/Plot menu. 

2. Add one or more details to the sheet. When you hover over a detail with 
your cursor, DataCAD highlights its extents, provides its scale, and 
displays its name as a tooltip. 

Detail names may contain up to 80 characters. 

3. Place your cursor on a detail and press Ctrl-right click. This displays a 
pop-up menu. 

4. Select Pen Table. The Pen Table Assignments dialog box appears. 

5. Supply the pen table you want to use for that detail and click OK. 
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Multiple Private Clipbooks with Preview 
DataCAD stores up to 10 private Clipbooks that contain the most recent data you 
copied from your drawing to the Windows Clipboard. Whenever you select 
Paste, you can re-select any of your Clipbooks. A preview of each Clipbook’s 
contents is shown when you highlight the item in the menu. 

Reference File Manager Enhancements 
You can assign XREF Highlight settings on a per-XREF and/or XREF Layer basis. 
The Reference File Manager dialog box allows you to drag-and-drop between the 
Loaded, Refresh, Reload, Bind, and Delete lists. You can also assign custom 
names to XREFs. The Inherit Current Highlight Setting option for nested XREFs 
is remembered on a per-drawing versus global basis. 

 
 

 To assign highlight settings: 

1. Select Reference File Management from the Insert pull-down menu, slide 
your cursor to the right, and select Manager from the submenu. 
Alternatively, you can press Ctrl-R to display the Reference File Manager 
dialog box. 

2. Select a loaded reference file to display its layers and views. 

3. Set highlighting options: 
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• X-Ref – sets highlights for the entire X-Ref when this box is checked. 
You can select the line type and color from the pull-down menus. 
Supply a value in the Spacing field. 

• X-Ref layer – sets highlights for one layer at a time when this box is 
checked. You must first highlight the name of the layer you want to 
use in the list of available XREF layers. 

If XREF highlighting is on and a layer within the XREF is also highlighted, the 
layer highlight settings supersede the overall XREF highlight settings. 

Change Menu Enhancements 
Two additional options are available in the Edit/Change/Text menu. You can 
now change the text angle and alignment.  

For the angle option, you simply supply the new value and press Enter.  

For the alignment option, the Alignment submenu offers additional choices. Left, 
Center, and Right are mutually exclusive; the same is true for Top, Middle, and 
Bottom. Reversed lets you draw text reversed about its height. Mirrored lets you 
draw text mirrored about its width. 
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